
A Note on Viewers
If you have not installed the Windows 95 QuickView file viewers, CleanSweep may not be able to 
display your files properly. 

To install the Windows 95 viewers:

1 Click the Windows 95 Start button.

2 Point to Settings, and then click Control Panel.

3 Double-click Add/Remove Programs.

The Add/Remove Programs Properties dialog box appears.

4 Choose the Windows Setup tab.

5 Click Accessories, then the Details button below.

6 Scroll down until you see Quick View, then select its check box.

7 Click OK, and then follow any instructions.



Adding or deleting install program names

The Install Monitor recognizes that you are installing a program when you type any of the 
program names listed in the Program Names list box. For example, when you installed 
CleanSweep, you typed A:\SETUP.    CleanSweep recognizes the SETUP command as initiating 
an installation program and begins monitoring the process. You can add or delete names of install 
programs.

To add install program names:

1 Click the Names button.

The Install Program Names dialog box appears.

2 Click Add.

The Add Install Name dialog box appears.

3 Enter the install program name. 

4 Click OK to add the install program name.

To delete install program names:

1 Click the Names button.

The Install Program Names dialog box appears.

2 Select the install program name to delete.

3 Click Delete.

A dialog box asks if you want to delete the install program name.

4 Click OK.



Archiving
When you have reviewed the summary information and are satisfied that it is correct, you are 
ready to archive.

To archive the program:

1 Click the Finish button.

That's all there is to it.CleanSweep creates an archive of the program, and creates a 
shortcut in the Start / Programs / Archives folder.

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in the next topic.

2 When you have finished viewing the summary, click the OK button.



Finding and Selecting a Folder or Program
To find and select a program, you can:

· Select a folder, or open it and select one of the programs inside it.

· Browse or search for a program and then select it.

Related topics:

Selecting a program or a folder

Finding files



Finding files

The methods described in this section locate individual files, rather than entire programs or 
program folders. These methods can help if you wish to find a program, but cannot remember 
where it is stored. These are also the only ways to find orphaned or DOS programs using the 
Archive wizard (although you may find such programs easily using options on the Cleanup tab).

MORE INFO:    You may also use the Cleanup tab to search for specific file types, such as 
duplicate, unused, or orphaned files. 

Related topics:

Browsing for a program

Searching for a program



Selecting a program or a folder

Use this method to select either a program contained within a folder or the folder itself and its 
entire contents. The Archive wizard displays all of your Program folders in alphabetical order.

To select a folder (or a single progam inside it):

1 Scroll the list to find the folder. If you wish to archive a single program, find the folder 
that contains the program.

2 To select all of the programs contained in a folder, simply click on the folder. To select 
a single program from within the folder, double-click the folder to display its contents, 
then click the program you want. If you wish to close the folder without selecting a 
program, double-click the folder again.

NOTE:    If you cannot find a program in a folder, it may be a DOS program or an "orphaned 
program." DOS programs do not appear in this list but you can use another method to find them, 
as described in the next topic. An orphaned program is a Windows program for which no icon 
exists in your folders.

To select a DOS program or an orphaned program, click on Find, and then use the Browse button 
or Search button. Browse lets you locate programs by navigating through your folders and 
making selections with the mouse or by selecting files by name or by wildcard. Search scans your 
local hard drives for all program files.

The Cleanup tab provides the best ways to find specific types of files¾for example, duplicate or 
temporary files. 

3 Click the Next button, or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components.    CleanSweep then asks for an archive destination folder. See 
selecting an archive folder.

IMPORTANT:    During its analysis, CleanSweep may determine that you have selected a file or a 
group of files that you should not archive. If so, a dialog box will warn you not to archive the 
program and will explain the reason why. You should follow the wizard's recommendations unless 
you are absolutely sure that the file can be safely archived. After the warning, CleanSweep 
continues with the archive process. The files that CleanSweep believes should not be archived 
are color coded in yellow or red.    Later in    reviewing your selection, CleanSweep will display a 
list of files to be archived, and will give you a chance to remove from the list any files marked in 
yellow. CleanSweep will not remove any files marked in red.



Browsing for a program

Use this method to select any single file from a folder.

To browse for a program:

1 Click the Browse button.

The Browse for a Program dialog box appears. The default folder is that of the 
selected program or folder. If you have not selected a program or folder, the default is 
the folder in which Windows resides. The main window in this dialog displays a 
scrollable list of files and folders.

To move up a level in the "folder tree," press the Up One Level button on the toolbar. 
To look in folder above the current one, or to look on another drive, , click the list box 
labelled Look in. To look in a folder within the current folder, double click on the folder 
in the main window below the Look in box.

To see more details about the files and folders in the main window, click the Details 
button on the toolbar.

NOTE:    The dialog box arranges the items alphabetically by name¾folders first, and then the 
files.

2 Select a file or type a filename in the Filename entry field. In Windows 95, a filename 
can be more than eight characters, and may contain periods, commas, hyphens, 
exclamation points, and spaces. If you do not know the entire filename, you can use 
the asterisk (*) or question mark (?) as wildcard characters. The dialog box displays 
only program files by default. To display all file types, click the "Files of type" list box, 
and then select All Files (*.*).

3 Click the Open button.

The wizard does a quick analysis of the file, then asks for an archive destination 
folder. See selecting an archive folder



Searching for a program

Use this method to locate a single file from a list of specific program types, including all programs, 
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Press the Search button.

The Search for a Program dialog box appears.

2 The wizard searches all local hard drives by default. To specify other drives to 
search, click the Drives To Search: box, select one or more drives from the dialog 
box, then click OK.

The wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click anywhere in the Files of Type list box, then choose 
Windows Programs, DOS Programs, or Dynamic Link Libraries.

3 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

NOTE:  Because Windows 95 supports long filenames, some file listings may contain the symbol 
~. This generally indicates that the long file or folder name is longer than what is displayed in the 
dialog box.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and how many bytes the file occupies.

5 After you have selected a file, click OK.

The wizard does a quick analysis of the file, then prompts you for a destination folder 
for the archive. See Selecting an archive folder



Overview
In this topic you will learn:

· How to archive a program and its related components to save space on your computer's 
hard disk.

· How to view a summary report of what was archived. 

You can reclaim hard disk space easily and safely by archiving programs that you need only 
occasionally. CleanSweep can remove a single program or all of the programs in a folder. 
Program files and all of the components associated with them are stored in a    compressed 
format for future retrieval. The compressed archive takes only a fraction of the disk space of the 
original program. The archived program can be restored easily with a click of the mouse.

The basic steps to archiving a program are:

1. Run the Archive wizard

2. Select the program or folder to archive

3. Select a destination folder

4. Review your selection

5. Archive the program or folder

The rest of this topic describes these steps in detail.



Reviewing your Selection
Next, the Archive wizard displays a summary of what it is about to do. The summary notes which 
file or files will be archived and the number of bytes of disk space that will be freed.

The View button on this screen displays a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to archive them. You can also change or print the list of displayed files before you 
continue. You might want to print the list so you can cancel the archive and verify each file on 
your own, or, you might keep the printout as a record of what you archived.

If you are sure you want to archive all the files listed, continue archiving.

Related topic:

Examining the list in more detail



Examining the list in more detail

To examine the list closely:

· Click the View button.

The Select the Components to Archive dialog box displays the title of the folder (if 
any), and the filenames and related components to be archived. The files and 
components are grouped by their "parent" program. By default, CleanSweep will 
preselect for deletion all files with a green safety level¾all files that CleanSweep is 
sure can be archived safely. Files with a yellow safety level are also candidates for 
archiving, but CleanSweep will not archive them unless you specificially select them. 
When you add a file or component to the list (see the next topic) CleanSweep 
displays its safety level as blue, indicating that CleanSweep has not given its own 
safety level to the file

The wizard uses Windows file viewers to let you take a quick peek at a file without having to 
launch the application that created it. After you have verified the file's contents, you can better 
decide whether you wish to archive it. This adds another layer of safety to the archiving process.

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can 
use the Run button to launch the program.

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button to display a description of any DLL the file uses, or any programs that depend 
upon that file.

2 Click the View or Run button.

The file appears (or the program launches).

To see a file description without launching the file:

· Select the filename in the list.

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to archive, you should clear their check boxes.

To prevent a file from being archived:

· Clear the check box by clicking on it.

To add a file to the list:

1 Click the Add button. 

The Add Component dialog box appears.



2  Type a filename in the file entry area, then click OK.

You may specify a filename, or you may choose to remove sections from the WIN.INI 
file. The WIN.INI file contains sections that are often shared between programs from 
the same vendor, so only select a section if you are absolutely sure it is not used by 
another program.

To print the list:

1 Click the Print List button.

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Viewing a Summary
When the archive is complete, a dialog box reports the action as completed, and asks if you want 
to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears. The text window contains a detailed description of the 
actions performed, including the following:

·    Date and time that the archive was performed

·    Object that was archived

·    Archive destination

·    Title of the folder, if applicable

·    Title of the program 

·    The complete pathname for each program in the folder or group 

·    Description of the program 

·    Number of bytes archived. 

Note:    The number of bytes archived might be slightly larger than the approximate estimate 
(listed just before you click the Finish button) due to "slack space."    Each file is stored in clusters 
of a certain size, depending on the hard disk's partition size.    The last cluster of a file takes a full 
cluster, whether it uses the space or not.    For example, if your hard disk partition contained 
4096-byte clusters, archiving a 4097-byte file would free 8192 bytes of disk space.

To print the report:

· Click the Print button.

The report is printed.

To save the report in a file:

1 Click the Save button.

The Save Summary to File dialog box appears.

2 Type a filename for the report, then click Close.

To close the report:

· Click the Close button.



The report closes.

More Info:  The summary report describes only the activity that has just been performed. For a 
report on all of CleanSweep's activity, take a look at the Master Log report, as described in View 
Master Log.



Archiving Instructions
If you are uneasy about uninstalling a program because you think there is a chance you might 
need it in the future, you can archive it.    The Archive Wizard creates a backup of a program in a 
compressed format for future retrieval.    The original files and configuration information are 
deleted from your computer.    When you need the program, simply click its archive icon and 
CleanSweep restores it.

This topic explains how to archive a complete program from your hard drive.    New users should 
read Running the Archive Wizard before using this quick start.

To archive a program:

1 Start CleanSweep

Click the Start button, point to Programs, and then click the Quarterdeck 
CleanSweep 95 icon.    CleanSweep appears.

2 Start the Archive Wizard

Click the Archive Wizard icon in the Program tab.    The Archive Wizard dialog box 
appears.    The wizard will guide you through the archive process.

3 Select the Program to Archive 

Double-click a folder to open it.    Click the program you want to archive.    If you 
cannot find the program in a folder, click the Find button.    Click Next. 

4 Select an Archive Destination 

Click Next again if the folder shown is where you want your backup copy of the 
program to go. 

Click Next to bypass the confirmation of each item archived. 

5 Start Archiving 

Click Next.    The wizard archives the program and asks if you would like to view a 
summary.    Click Summary. 

6 Archive Complete!

Click Finish.    A double-box frame surrounds the program's original icon to indicate it 
is archived.    To restore the program, simply double-click the icon.



Archiving files

Choose the Archive selection to compress and back up the selected files. The files are not 
deleted from their original location. CleanSweep creates an icon for the archived items in your 
Windows shell so that you may restore the archive easily.

To archive files:

1 Click Archive and then click Next.

2 Type the folder in which you would like to keep the archive file or click Next to accept 
the default folder.    The default folder is

C:\Program Files\Cleansweep\Backup

3 Click View to look at a list of files to be archived. Click Finish to archive the files.

4 CleanSweep will prompt you if you wish to create an archive icon. If so, CleanSweep 
will create an icon in the Archives program group in your Windows shell. Clicking on 
this icon will start CleanSweep, and take you automatically to the Restore Wizard.



Finding and Selecting a Folder or Program
To find and select a program, you can:

· Select a folder, or open it and select one of the programs inside it.

· Browse or search for a program and then select it.

Related topics:

Selecting a program or a folder

Finding files



Finding files

The methods described in this section locate individual files, rather than entire programs or 
program folders. These methods can help if you wish to find a program, but cannot remember 
where it is stored. These are also the only ways to find orphaned or DOS programs (although you 
may find such programs easily using options on the Cleanup tab).

MORE INFO:    You may also use the Cleanup tab to search for specific file types, such as 
duplicate, unused, or orphaned files.

Related topics:

Browsing for a program

Searching for a program



Selecting a program or a folder

Use this method to select either a program contained within a folder or the folder itself and its 
entire contents. The wizard displays all of your Program folders in alphabetical order.

To select a folder (or a single progam inside it):

1 Scroll the list to find the folder. If you wish to package a single program, find the 
folder that contains the program.

2 To select all of the programs contained in a folder, simply click the folder. To select a 
single program from within the folder, double-click the folder to display its contents, 
then click the program you want. If you wish to close the folder without selecting a 
program, double-click the folder again.

NOTE:    If you cannot find a program in a folder, it may be a DOS program or an "orphaned 
program." DOS programs do not appear in this list but you can use another method to find them, 
as described below. An orphaned program is a Windows program for which no icon exists in your 
folders.

To select a DOS program or an orphaned program, click Find, and then use the Browse button or 
Search button. Browse lets you locate programs by navigating through your folders and making 
selections with the mouse or by selecting files by name or by wildcard. Search scans your local 
hard drives for all program files.

The Cleanup tab provides the best ways to find specific types of files¾for example, duplicate or 
temporary files. 

3 Click the Next button, or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components.    CleanSweep then asks for a destination. See Selecting a 
Destination



Browsing for a program

Use this method to select any single file from a folder.

To browse for a program:

1 Click the Browse button.

The Browse for a Program dialog box appears. The default folder is that of the 
selected program or folder. If you have not selected a program or folder, the default is 
the folder in which Windows resides. The main window in this dialog displays a 
scrollable list of files and folders.

To move up a level in the "folder tree," press the Up One Level button on the toolbar. 
To look in folder above the current one, or to look on another drive, click the list box 
labelled Look in. To look in a folder within the current folder, double click the folder in 
the main window below the Look in box.

To see more details about the files and folders in the main window, click the Details 
button on the toolbar.

NOTE:    The dialog box arranges the items alphabetically by name¾folders first, and then the 
files.

2 Select a file or type a filename in the Filename entry field. In Windows 95, a filename 
can be more than eight characters, and may contain periods, commas, hyphens, 
exclamation points, and spaces. If you do not know the entire filename, you can use 
the asterisk (*) or question mark (?) as wildcard characters. The dialog box displays 
only program files by default. To display all file types, click the "Files of type" list box, 
and then select All Files (*.*).

3 Click the Open button.

The wizard does a quick analysis of the file, then asks for a destination. See 
Selecting a Destination.



Searching for a program

Use this method to locate a single file from a list of specific program types, including all programs, 
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Press the Search button.

The Search for a Program dialog box appears.

2 The wizard searches all local hard drives by default. To specify other drives to 
search, click the Drives To Search: box, select one or more drives from the dialog 
box, then click OK.

The wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click anywhere in the Files of Type list box, then choose 
Windows Programs, DOS Programs, or Dynamic Link Libraries.

3 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

NOTE:  Because Windows 95 supports long filenames, some file listings may contain the symbol 
~. This generally indicates that the long file or folder name is longer than what is displayed in the 
dialog box.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and how many bytes the file occupies.

5 After you have selected a file, click OK.

The wizard does a quick analysis of the file, then prompts you for a destination. See 
Selecting a Destination.



Overview
In this topic you will learn:

· How to compress and "package" a program and all of its associated components into one 
file. Once you create the file, you can use it as a backup copy or transport it to another 
computer, such as your laptop. 

· How to view a summary report of what was packaged.

The packaged program file takes only a fraction of the disk space of the original program. The 
original program remains intact. To restore the program, simply run the Restore wizard, which is 
much easier than reinstalling and reconfiguring. 

Related topic:

Which wizard should I use?



Reviewing your Selection
Next, the wizard displays a summary of what it is about to do. The summary notes which file or 
files will be packaged and the number of bytes of disk space that will be packaged.

The View button on this screen displays a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to package them. You can also change or print the list of displayed files before you 
continue. You might want to print the list so you can cancel the process and verify each file on 
your own, or, you might keep the printout as a record of what you packaged.

If you are sure you want to package all the files listed, continue with Packaging.

Related topic:

Examining the list in more detail



Examining the list in more detail

To examine the list closely:

· Click the View button.

The Select the Components dialog box displays the title of the folder (if any), and the 
filenames and related components to be packaged. The files and components are 
grouped by their "parent" program.

The wizard uses Windows file viewers to let you take a quick peek at a file without having to 
launch the application that created it. After you have verified the file's contents, you can better 
decide whether you wish to package it. 

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can 
use the Run button to launch the program.

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button to display a description of any DLL the file uses, or any programs that depend 
upon that file.

2 Click the View or Run button.

The file appears (or the program launches).

NOTE:    If the file does not display properly, you may have to install the Windows 95 
Quick View file viewers. For installation instructions, see your Windows 95 
documentation or A Note on Viewers.

To see a file description without launching the file:

· Select the filename in the list.

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to package, you should clear their check boxes.

To prevent a file from being packaged:

· Clear the check box by clicking on it.

To add a file to the list:

1 Click the Add button. 

The Add Component dialog box appears.

2  Type a filename in the file entry area, then click OK.



To print the list:

1 Click the Print List button.

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Selecting a Destination
Before CleanSweep packages anything, it asks where you want to store the package.

To select a destination:

1 Click the Next button.

A dialog box shows the name of the default destination.

The default folder in the Backup wizard is

C:\PROGRAM FILES\CLEANSWEEP\BACKUP

The Transport wizard defaults to the first removable hard drive on your computer, 
typically drive A:.    This destination is the intermediate location, used to transport the 
file from one computer to another.

You can choose a different destination by editing the displayed folder name or drive. 
Click the … button to browse for a different destination.

2 Click the Next button to store the package in the currently selected folder.



Viewing a Summary
When the package is complete, a dialog box reports the action as completed, and asks if you 
want to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears. The text window contains a detailed description of the 
actions performed, including the following:

· Date and time that the action was performed

· Object that was packaged

· Package destination

· Title of the folder, if applicable

· Title of the program 

· The complete pathname for each program in the folder or group 

· Description of the program 

· Number of bytes packaged. 

To print the report:

· Click the Print button.

The report is printed.

To save the report in a file:

1 Click the Save button.

The Save Summary to File dialog box appears.

2 Type a filename for the report, then click Close.

To close the report:

· Click the Close button.

The report closes.

MORE INFO:  The summary report describes only the activity that has just been performed. For a 
report on all of CleanSweep's activity, take a look at the Master Log report, as described in View 
Master Log.



Backing up files

Use the Back Up option to back up files without deleting them, and without creating an icon as 
the Archive option does.

To back up files:

1 Click Back up and then click Next.

2 Type the name of the folder in which you would like to keep the backup file or click 
Next to accept the default folder. The default folder is

C:\Program Files\Cleansweep\Backup

3 Click View to look at a list of files to back up. Click Next to back up the files. 



Backing up the files

Before CleanSweep deletes anything, it asks if you want to create a compressed backup copy of 
the items you uninstall.    The default is yes.    We recommend that you make a backup unless you 
are sure that you want to permanently delete the selected items from your computer.

To back up the items you uninstall:

1 Click the Next button.

A dialog box shows the name of the default backup folder, C:\PROGRAM 
FILES\CLEANSWEEP\BACKUP.    You can choose a different backup folder by 
editing the displayed folder name or by clicking the ... button and browsing for a 
different folder. 

2 Click the Next button to store the backup in the currently selected folder.



Browsing for a backup

Use this method to select a backup from a folder other than CleanSweep's default backup folder. 

To browse for a backup:

1 Press the Browse button.

The Browse for CleanSweep Backup dialog box appears.    The default folder is the 
default CleanSweep backup folder. 

NOTE:    The Restore Wizard Browse dialog box differs from the Browse dialog boxes in the other 
wizards in that it displays only backup files created by CleanSweep.

To look in another folder or change drives,    click the drop-down button in the Look in: 
drop-down list box and then make another selection.

The dialog box lists the backup files in alphabetical order.    Backup files have the 
extension BUP, BUD, or BUA.

To see more details about the files, click the Details button.

To move up a level in the "folder tree," press the Up One Level button.

2 Select a file or type a filename in the Filename entry field.    If you do not know the 
entire filename, you can use the asterisk (*) or question mark (?) as wildcard 
characters.    By default, the dialog box displays program files.    To browse for all file 
types, click the drop-down button in the files of type drop-down list box, and then 
select All Files (*.*).

3 Click Open.

4 Click Next.

CleanSweep determines which files are in the backup file and displays a list.    You can either 
choose to restore all the files or you can remove files from the list to restore a portion of the 
program.

To restore all files:

· Click Next.

To remove a file from the list:

1 To remove a file from the list, clear its checkbox.

2 Click Next.



Changing Backup and Restore Options
Use the Backup and Restore options to control where backup files are stored, what you want the 
Restore wizard to do when it finds files with the same name, and whether you want to be alerted 
if a backup file is older than a certain number of days.

To change the Backup/Restore options, first select the Backup/Restore tab.

To select the Backup/Restore tab:

1 Click the Options tab.

2 Click the Customizing CleanSweep icon.

3 Click the Backup/Restore tab.

Related topics:

Changing the default backup folder

Turning off Uninstall Wizard file confirmation

Turning off Restore Wizard options

Receiving a reminder to remove old backup files



Changing the Default Report File
CleanSweep uses C:\PROGRAM FILES\CLEANSWEEP\REPORT.TXT as the default report 
filename when you save a summary report. This section describes how to change the default 
report filename.

To select the View tab:

1 Click the Options tab.

2 Click the Customizing CleanSweep icon .

3 Click the View tab.

To rename the default report filename:

1 Type the new filename in the Default Report File box.

2 Click Apply to change the default report file without closing the View tab.

Or

· Click OK to change the default report file and exit the View tab.

To store summary reports in an existing file:

1 Click the ... button beside the default report file.

The Search for Default Report File dialog appears.

2 Select the default report file and click Open.

3 Click Apply to accept the default report file without closing the View tab.

Or

· Click OK to accept the default report file and exit the View tab.



Changing the default backup folder

CleanSweep uses C:\PROGRAM FILES\CLEANSWEEP\Backup as the default backup folder. 

To enter a new default backup folder:

1 Enter the new folder name in the Default Backup Folder box.

2 Click Apply to change the default backup folder without closing the Backup/Restore 
tab

Or

· Click OK to change the default backup folder and exit the Backup/Restore tab.

To search for a default backup folder:

1 Click the ... button beside the default folder name.

The Browse for Default Backup Directory dialog box appears.

2 Select the default backup folder.

3 Click Apply to change the default backup folder without closing the Backup/Restore 
tab, or click OK.

Or

· Click OK to change the default backup folder and exit the Backup/Restore tab.



Cleaning Up Unneeded Files
After you find and select items in a Finder window, you can click the Clean button to start the 
backup and deletion process. CleanSweep is designed to remove unneeded files and 
associations safely, and the Clean function has several safeguards built in to keep you from 
permanently losing any programs, files, or settings that you discover later are important. You can 
also create archives of your programs without deleting them, and keep a record of any changes 
that CleanSweep makes to configuration files or system settings.

The five ways to clean up files are to:

· Delete them

· Archive them

· Back them up

· Move them

· Transport them

Related topics:

Deleting files

Archiving files

Backing up files

Moving files

Transporting files



Configuring the Install Monitor
The Install Monitor runs in the background to keep track of all files added and any changes made 
to existing configuration files when you install a program on your computer. CleanSweep uses 
this information later if you want to uninstall a program and its related files to ensure safe and 
thorough uninstallations. 

Installing CleanSweep automatically activates the Install Monitor.    After CleanSweep installation, 
the Install Monitor starts automatically as part of the Windows startup process.    The Install 
Monitor remains active as long as Windows is running.    An icon appears at the bottom of your 
desktop to indicate that the monitor is running. 

When you install CleanSweep, the Install Monitor is normally started as part of the Startup 
process.

To configure the Install Monitor, first select the Install Monitor tab:

To select the Install Monitor tab:

1 Click the Options tab.

2 Click the Customizing CleanSweep icon.

3 Click the Install Monitor tab.

Related topics:

Turning the Install Monitor off or on

Preventing the Install Monitor from loading at startup

Adding or deleting install program names

Viewing or deleting Install Monitor logs



Configuring the Usage Monitor
The Usage Monitor runs in the background and makes a note each time you use a file on your 
computer. The Unused and Low Usage File Finders use this information to determine which files 
may no longer be needed.

Installing CleanSweep automatically activates the Usage Monitor.    After CleanSweep installation, 
the Usage Monitor starts automatically as part of the Windows startup process.    The Usage 
Monitor remains active as long as Windows is running.    An icon appears at the bottom of your 
desktop to indicate that the monitor is running. 

To select the Usage Monitor tab:

1 Click the Options tab.

2 Click the Configure CleanSweep icon.

The Usage Monitor tab appears.

Related topics:

Turning the Usage Monitor off or on

Preventing the Usage Monitor from loading at startup

Setting Usage Monitor alert options



Confirming file deletion

The Uninstall wizard asks whether you want to confirm the deletion of each file.    During 
confirmation, you can view a text, graphic, or document file before it is deleted to verify that you 
want to delete it. 

To uninstall without confirming each file:

· Click the Next button.

To confirm each deletion:

1 Click the Yes button.

2 Click the Next button.



Overview
In this topic you will learn:

· How to control the Usage Monitor, including how and when the monitor will alert you 
to unused or infrequently used files.

· How to control the Install Monitor, including what the monitor will recognize as an 
installation program and how to view installation log reports.

· How to control safety precautions in the Backup and Restore wizards and whether 
you want to be alerted if you have old backup files on your computer.

· How to change the default report filename.

Use the Configure CleanSweep option on the Options tab to change the way CleanSweep 
operates to suit your preferences.

The basic steps for customizing CleanSweep are:

1 Choose the Options tab from the CleanSweep main window.

2 Click the Customizing CleanSweep icon.

3 Choose the Usage Monitor, Install Monitor, Backup/Restore, or View tab.

4 Confirm or change the desired options.



Defining the Search Criteria

Before you select duplicate files, you may wish to revise the criteria CleanSweep will use to 
determine whether files are duplicates.

To define the file search criteria:

1 Click the Search For drop-down button.

The list of search criteria choices appears.

Search Criteria What it Finds

Files with the same name 
and size

Finds files with the same name and size. 
This is the default selection.

Files with the same 
name, size, date, and 
time

Finds files with the same name, size, date, 
and time. This is the most restricted search. 
In most cases you can safely delete files 
which are older than their duplicates.

Files with the same name 
only

Files with the same name will be listed, 
regardless of size, date, or time. This is the 
least restricted search. 

2 Click the desired search criteria.

NOTE: Two files with the same name are not necessarily duplicates. If two files have the same 
size, date, and time, then there is a high probability that they are identical and you can safely 
delete one of them. If two files have the same name but do not have the same size, date, and 
time, the newer one is normally more up-to-date, and the older one is the better candidate for 
removal. There is no guarantee that files with the same name are identical or even related to one 
another. You can use the View button to view the files and determine which files are duplicates 
and which are unique.



Deleting files

Choose the Delete selection to remove files and optionally create a backup copy of them. Delete 
is the default selection.

IMPORTANT:    CleanSweep provides safeguards to prevent the loss of essential programs and 
files. However, we always recommend that you back up files before deleting them to make sure 
they can be recovered if you experience problems. 

To delete files and make a backup copy:

1 Click Delete and then click Next.

2 Click Next to delete the files and create a backup of the files.

3 Click Next to confirm or change the folder for the backup. The default folder is: 

C:\Program Files\Cleansweep\Backup

To change the backup folder or send the backup to a floppy disk, removable drive, or 
other device, type the new directory or drive name (for example, A: or C:\BACKUP) in 
the space provided.

4 To confirm each deletion, choose Yes. Click Next to delete the files without 
confirming each deletion. 

5 Click View to look at a list of files to delete. Click Next to delete the files. 

To delete files without making a backup copy:

1 Click Delete it and then click Next.

2 Choose No to cancel the backup. Click Next.

3 A dialog box warns you that creating a backup is always recommended. If you are 
sure you do not want a backup, click Yes.

4 To confirm each deletion, choose Yes. Click Next to delete the files without 
confirming each deletion. 



Deleting the Backup File
A dialog box asks if you want to delete the old backup file once the files have been restored.    If 
you will not need the backup, it is a good idea to delete it to free additional disk space. 

To delete the backup file:

· Click Next. 

To save the backup file:

· Click No, and then click Next. 



Exit CleanSweep
To exit CleanSweep:

· Click the Exit button.



File replacements

If a file being restored already exists in the destination folder, you need to tell CleanSweep which 
action to take.    You have three choices:    you can replace files only if they are older than the file 
you are restoring, you can replace all files, or you can never replace files, just add new ones.

To replace only older files:

· Click the Next button.

To replace all duplicate files:

· Click the Replace all files option button.

To never replace files:

· Click the Never replace files, only add new files option button.



Finding Duplicate Files
Use the Duplicate File Finder to locate and remove files with the same name. Duplicate files may 
be caused by installations of the same program into different folders, or by copying the contents 
of a folder from one location to another. You may have edited a file in one folder and saved the 
updated version to another folder. Removing duplicate files can free valuable hard disk space and 
improve performance. 

To find duplicate files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Duplicate File Finder icon.

The Duplicate File Finder window appears.

Related topics:

Defining the Search Criteria

Selecting the Drive to Search

Selecting the File Type

Selecting Files



Finding Infrequently Used Files
CleanSweep's File Usage Monitor makes a note each time you use a file on your system, and 
stores a table of this information for the Low Usage File Finder. Use this feature to list files based 
on how many times they have been accessed since they were created (or since you installed 
CleanSweep). Note, however, that the information displayed by the Low Usage File Finder is only 
accurate if the File Usage Monitor is enabled constantly on your computer.

IMPORTANT:    The CleanSweep Usage Monitor must be installed and running for this function to 
report accurate access information.

To find infrequently used files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Low File Usage Finder icon.

The Low File Usage Finder window appears.

Related Topics:

Selecting File Sorting Options

Selecting File Sorting Order

Selecting the Drives to Search

Selecting File Type

File Information



Finding Orphaned Files
When you delete an application from your computer without a program like CleanSweep, there's 
a good chance that your system will require some tidying up. Use the Orphan Finder to list stray 
files and file associations in WIN.INI, or files related to applications that are no longer on your 
computer. 

To find orphan files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Orphan Finder icon.

The Orphan Finder window appears.

IMPORTANT:    Make sure you do not delete files that are required by applications on CD-ROM. 
False orphans may appear if your computer does not have access to the CD-ROM.

Related topics:

Selecting the Orphan Type

Selecting the Drives to Search

Selecting Orphan Files



Finding Redundant DLL Files
Use the Redundant DLL Finder to locate and remove duplicate DLL or VBX files. DLL (Dynamic 
Link Library) and VBX (Visual Basic eXtension) files can contain program code or other kinds of 
resources such as icons, bitmaps, controls, and dialogs, and can be used by one or more 
applications at the same time. Programming tools for Windows include copies of useful (and 
sometimes very large) DLLs that can be distributed as part of the finished application. While the 
installation routines for some products are intelligent enough to check your system for pre-
existing copies of common DLLs, many are not so bright and instead install yet another copy. 
Therefore, you can have multiple copies of the same file taking up the dwindling space on your 
hard disk.

To find redundant DLL and VBX files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Redundant DLL Finder icon.

The Redundant DLL Finder window appears.

Related topics:

Selecting the Drives to Search

Selecting DLL or VBX Files



Selecting the File Type

Use the Files of Type option to limit the search for duplicate files in specific categories.

To select the file type:

1 Click the Files of Type drop-down button. 

The list of file type choices appears.

File Type Searches For

All Files Duplicate file of all types. This is the 
default selection. It finds the most files, 
but takes the longest time.

(Add Custom 
File Type)

Files with specific file extensions. Type 
the file extension, or a list of extensions, 
in the Add Custom File Type dialog.

Programs BAT, COM, EXE, or PIF (Windows 
Program Information File) files.

Dynamic Link 
Libraries

DLLs and VBXs

IMPORTANT:    Use caution when deleting duplicate BAT, COM, or EXE, DLL, or VBX files. Some 
programs may require particular versions of these files to run properly. Although CleanSweep will 
prevent you from deleting files that are essential to the operation of DOS or Windows, you should 
always make a backup of programs and DLLs.

2 Click the desired file type or choose Add Custom File Type to enter a specific file 
extension.



File Information

The scrollable list shows the duplicate files and their locations, sizes, dates, and times. It also lists 
the number of times the files have been accessed since CleanSweep's Usage Monitor has been 
enabled (the default number is 1). Below the file list is an icon that tells you the kind of file that is 
currently highlighted. You can select any file from the list and mark it for deletion. You can also 
have CleanSweep give you more information about the file so you can decide what to do with it.

To select infrequently used files:

1 Click the check box beside the pathname for the selected file. 

Any file, regardless of how frequently it is used, could be important and should be 
deleted with caution. For this reason, CleanSweep displays the safety level of each 
file as yellow.

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that the checkmark displays in its check box. While the 
file is highlighted, you may choose to display more information about it (see the next 
topic).

3 To deselect a single file, click anywhere on its line to remove the checkmark. To 
deselect all files, click the Deselect All button.

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

The following actions are available in the Duplicate File Finder.

Action What it Does

Clean Begins the backup and deletion process. Clean 
provides several options for handling selected 
files (see Cleaning Up Unneeded Files).

Advise Offers a summary describing the highlighted file 
in more detail, and advice on what to do with it.

View Activates a Windows viewer or launches an 
application for the highlighted file. If the file is in a 
format unknown to Windows, but contains mostly 
text, the contents of the file are displayed. For 
most Windows application and system files, a 
summary of information from the file's header 
appears. The button is only active if a file is 
highlighted in the scrolling window.

Links Activates a dialog that lists files that use this file, 



or files that this file uses. This button is activated 
only if a DLL or VBX file is selected.

Run Executes the highlighted file. This button is 
activated only if the selected file is executable 
(BAT, COM, EXE, or PIF).

Deselect All Deselects all selected files in the scrolling 
window.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drives to search:

1 Click the Drives to Search field. 

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drives to search:

1 Click the Drives to Search window. 

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drive to search:

1 Click the Drive to Search field. 

The Select Drive dialog box appears.

2 Click the desired drive to search.

3 Click OK to confirm your drive selection.



File Information

The lower scrollable list shows the name, size, path, date, and time of each file in the category 
selected above. It also lists the number of times the files have been accessed since 
CleanSweep's Usage Monitor has been enabled (the default number is 1). Beside each listed file 
is a box, color-coded to indicate the safety level associated with deleting the file. A red box 
signifies that the file is in use, and may not be deleted. A yellow box appears next to files that 
CleanSweep believes may be useful. Such files should be deleted with caution. A green box 
indicates that the file is clearly redundant, and can be removed safely. Such files are preselected 
for deletion.

To select unused files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete.To select a file, click 
anywhere on its line so that the checkmark displays in its check box. While the file is 
highlighted, you may choose to display more information about it (see the next topic).

3 To deselect a single file, click its yellow or green box. To deselect all files, click the 
Deselect All button.

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

Action What it Does

Clean Begins the backup and deletion process. Clean 
provides several options for handling selected 
files (see Cleaning Up Unneeded Files).

Advise Offers a summary describing the highlighted file 
in more detail, and advice on what to do with it.

Custom Provides a dialog for specifying a custom file 
search string. For example, you could specify 
*.ASC to search for all files with the .ASC 
extension, *.WK1 to find all of your Lotus 2.x 
spreadsheets. You can specify more than one 
extension to search for by separating each 
extension with a space. You can also use the 
DOS wildcards (* and ?) in the custom file 
search string.    CleanSweep stores this 
information between sessions. Use this feature 
to customize CleanSweep's Unused File Type 
Finder to suit your needs.



View Activates a viewer for the highlighted file. If the 
file contains text, the contents of the file are 
displayed. For most Windows application and 
system files, a summary of information from the 
file's header appears. This button can only be 
selected if a file is highlighted in the scrolling 
window.

Links Activates a dialog that lists files that use this file, 
or files that this file uses. This button is activated 
only if a DLL or VBX file is selected.

Run Executes the highlighted file. This button is 
activated only if the selected file is executable 
(BAT, COM, EXE, or PIF), or if the file is 
associated by Windows with a specific program.

Select All Selects all files in the scrolling window.

Deselect All Deselects all files in the scrolling window.



Selecting the Drives to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drives to search:

1 Click the Drives to Search field. 

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting the File Type

The scrollable list at the top of the window gives a list from which you can select various 
categories of files (archive files, display drivers, fonts, etc.). CleanSweep displays the number of 
files and the total size of the files in each category.    For each file category the number of files 
and the cumulative size of the files is listed. CleanSweep also uses color to display the safety 
level of each type of file. In some categories, different files might have different safety levels; for 
such categories, multiple safety levels will be displayed.

MORE INFO:    For a detailed list of file types, refer to "Unused File Type Descriptions."

The lower scrollable list displays individual files of the type selected in the top list.

To select a file type:

· Click the file type you wish to display.

The unused files appear in the lower list.



Overview
In this topic you will learn:

· How to find and clean up duplicate files.

· How to find and clean up redundant DLL or VBX files.

· How to find and clean up unused or infrequently used files.

· How to find and clean up orphan files (files left behind by applications that have been 
deleted).

If you have tried to remove programs without using CleanSweep, you almost certainly have a 
large number of stray files remaining on your hard drive. Even after you have used CleanSweep 
to remove programs, your hard disk may still contain outdated or unneeded data files. The 
CleanSweep Finders can help to locate these types of    files for you.

The basic steps for removing unneeded files are:

1 Choose a Finder from the Cleanup tab.

2 Determine which files are no longer needed.

3 Select the unneeded files.

4 Select an action to clean up the files.



Finding Unused Files by Type
Many of the files on your system will be of similar types. For example, you may keep spreadsheet 
files over a period of several years, or you may download files of clipart from a BBS or from the 
Internet. As you make and move copies of these files on your hard drive, you may find that many 
files of similar types¾denoted by file extensions¾are never used and can be deleted safely. Use 
the Unused File Type feature to select files in categories that CleanSweep already knows, or 
create your own file categories and add them to CleanSweep's list. 

To find unused files:

1 Click the Cleanup tab.

The Cleanup window appears.

2 Click the Unused File Finder icon.

The Unused File Type Finder window appears.

Related topics:

Selecting the File Type

Selecting the Drives to Search

File Information



Folder Information

To view the folder information report, double-click the drive name or click the Folders button in the 
View Folder Usage window.    You can also choose Print or Save to print a copy of the report or 
save it to a file.

The Folder Information report provides the following information for each folder:

File count Number of files in the folder.

Actual size Actual space used by the files in the folder

Allocated size Total space allocated for the files in the folder

Percent used The percentage of files in the folder that have actually been used.



For extra safety

CleanSweep asks whether you want to confirm the replacement of each file.    The default is no.    
If you want the extra safety measure of confirming the replacement of each file, select yes. 

To restore without confirming each file replacement:

· Click the Next button.

To confirm each file replacement:

1 Click the Yes button.

2 Click the Next button.



Getting Help
CleanSweep's online help system provides a quick and easy way to get answers to your 
questions.

To access help:

· Click the Help button.

The Contents tab opens a window that lists the major topics available in Help system.

The Index tab opens the search window, used to look up topics using keywords or 
scrolling through a list of topics.

The Find tab opens a search window that you can use to search for specific words 
and phrases in Help topics, instead of searching by category.

Related topic:

Jump to another topic



Overview
In this topic you will learn:

· How to use CleanSweep's main window tabs.

· How to exit CleanSweep. 

· How to use this online Help system.



Quarterdeck CleanSweep 95

Quick Start
Welcome to CleanSweep

Uninstalling Instructions

Archiving Instructions

Getting Started

Overview

The Main Window at a Glance

Getting Help

Exit CleanSweep

Where To Go Next

Uninstalling

Overview

Running the Uninstall Wizard

Finding and Selecting a Folder or Program

Taking Safety Precautions

Reviewing your Selection

Uninstalling

Viewing a Summary

Uninstalling on a Network

Archiving

Overview

Running the Archive Wizard

Finding and Selecting a Folder or Program

Selecting an Archive Folder

Reviewing your Selection

Archiving

Viewing a Summary

Backing Up and Transporting

Overview
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Jump to another topic

On many Help screens, you will see words and phrases that appear in green with a solid 
underline.    These are jump terms that provide cross-references to other topics.    When you point 
to one, the cursor takes the shape of a pointing finger.    If you click a jump term, a Help window 
on that topic appears.    After you read the jump term's Help window, you can return to the original 
Help window by pressing the Back button.

You will also see words and phrases with dotted underlines.    These terms provide more 
information about the word or phrase underlined.    Click the word or phrase to display more 
information. 



Finding and Selecting a Folder or Program
To find and select a program, you can:

· Select a folder, or open it and select one of the programs inside it.

· Browse or search for a program and then select it.

Related topics:

Selecting a program or a folder

Finding files



Finding files

The methods described in this section locate individual files, rather than entire programs or 
program folders. These methods can help if you wish to find a program, but cannot remember 
where it is stored. These are also the only ways to find orphaned or DOS programs using the 
Move wizard (although you may find such programs easily using options on the Cleanup tab).

More Info:    You may also use the Cleanup tab to search for specific file types, such as duplicate, 
unused, or orphaned files. 

Related topics:

Browsing for a program

Searching for a program



Selecting a program or a folder

Use this method to select either a program contained within a folder or the folder itself and its 
entire contents. The Move wizard displays all of your Program folders in alphabetical order.

To select a folder (or a single progam inside it):

1 Scroll the list to find the folder. If you wish to move a single program, find the folder 
that contains the program.

2 To select all of the programs contained in a folder, simply click the folder. To select a 
single program from within the folder, double-click the folder to display its contents, 
then click the program you want. If you wish to close the folder without selecting a 
program, double-click the folder again.

NOTE:    If you cannot find a program in a folder, it may be a DOS program or an "orphaned 
program." DOS programs do not appear in this list but you can use another method to find them, 
as described in the next topic. An orphaned program is a Windows program for which no icon 
exists in your folders.

To select a DOS program or an orphaned program, click on Find, and then use the Browse button 
or Search button. Browse lets you locate programs by navigating through your folders and 
making selections with the mouse or by selecting files by name or by wildcard. Search scans your 
local hard drives for all program files.

The Cleanup tab provides the best ways to find specific types of files¾for example, duplicate or 
temporary files. 

3 Click the Next button, or double-click on the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components.    CleanSweep then asks for a destination. See Selecting a 
Destination

IMPORTANT:    During its analysis, CleanSweep may determine that you have selected a file or a 
group of files that you should not move. If so, a dialog box will warn you not to move the program 
and will explain the reason why. You should follow the wizard's recommendations unless you are 
absolutely sure that the file can be safely moved.

After the warning, CleanSweep continues with the move process. The files that CleanSweep 
believes should not be moved are color coded in yellow or red.    Later in Reviewing your 
Selection, CleanSweep will display a list of files to be moved, and will give you a chance to 
remove from the list any files marked in yellow. CleanSweep will not remove any files marked in 
red.



Browsing for a program

Use this method to select any single file from a folder.

To browse for a program:

1 Click the Browse button.

The Browse for a Program dialog box appears. The default folder is that of the 
selected program or folder. If you have not selected a program or folder, the default is 
the folder in which Windows resides. The main window in this dialog displays a 
scrollable list of files and folders.

To move up a level in the "folder tree," press the Up One Level button on the toolbar. 
To look in folder above the current one, or to look on another drive, , click the list box 
labelled Look in. To look in a folder within the current folder, double-click the folder in 
the main window below the Look in box.

To see more details about the files and folders in the main window, click the Details 
button on the toolbar.

NOTE:    The dialog box arranges the items alphabetically by name¾folders first, and then the 
files.

2 Select a file or type a filename in the Filename entry field. In Windows 95, a filename 
can be more than eight characters, and may contain periods, commas, hyphens, 
exclamation points, and spaces. If you do not know the entire filename, you can use 
the asterisk (*) or question mark (?) as wildcard characters. The dialog box displays 
only program files by default. To display all file types, click the "Files of type" list box, 
and then select All Files (*.*).

3 Click the Open button.

The wizard does a quick analysis of the file, then asks for a destination. See 
"Selecting a Destination."



Searching for a program

Use this method to locate a single file from a list of specific program types, including all programs, 
DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Press the Search button.

The Search for a Program dialog box appears.

2 The wizard searches all local hard drives by default. To specify other drives to 
search, click the Drives To Search: box, select one or more drives from the dialog 
box, then click OK.

The wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click anywhere in the Files of Type list box, then choose 
Windows Programs, DOS Programs, or Dynamic Link Libraries.

3 Use the scroll bar to move up and down the file list, and then click the filename to 
select it. You may only select one program at a time.

NOTE:  Because Windows 95 supports long filenames, some file listings may contain the symbol 
~. This generally indicates that the long file or folder name is longer than what is displayed in the 
dialog box.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and how many bytes the file occupies.

5 After you have selected a file, click OK.

The wizard does a quick analysis of the file, then prompts you for a destination. See 
Selecting a Destination.



Moving
When you have reviewed the summary information and are satisfied that it is correct, you are 
ready to move.

To move the program:

1 Click the Finish button.

That's all there is to it. CleanSweep moves the program.

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in the next topic.

2 When you have finished viewing the summary, click the OK button.



Overview
In this topic you will learn:

· How to move a program and all of its associated components to another directory on your 
computer.

· How to move a program and all of its associated components from your computer to a 
network, or vice versa.

· How to view a summary report of what was moved. 

You can use the Move wizard to relocate programs quickly and easily without reinstalling and 
reconfiguring.    When you move a program, all its related files are relocated to appropriate 
locations and all Windows settings are updated to reflect the new location.

The basic steps to moving a program are:

1. Run the Move wizard

2. Select the program or folder to move

3. Select a destination

4. Review your selection

5. Move the program or folder

The rest of this topic describes these steps in detail.



Reviewing your Selection
Next, the Move wizard displays a summary of what it is about to do. The summary notes which 
file or files will be moved and the number of bytes of disk space that will be moved.

The View button on this screen displays a description and the safety level of each file that 
CleanSweep believes is associated with your choice. You may be able to view some files to be 
sure you want to move them. You can also change or print the list of displayed files before you 
continue. You might want to print the list so you can cancel the move and verify each file on your 
own, or, you might keep the printout as a record of what you moved.

If you are sure you want to move all the files listed, continue with Moving.

Related topic:

Examining the list in more detail



Examining the list in more detail

To examine the list closely:

· Click the View button.

The Select the Components to Move dialog box displays the title of the folder (if any), 
and the filenames and related components to be moved. The files and components 
are grouped by their "parent" program. By default, CleanSweep will preselect for 
deletion all files with a green safety level¾all files that CleanSweep is sure can be 
moved safely. Files with a yellow safety level are also candidates for moving, but 
CleanSweep will not move them unless you specifically select them. When you add a 
file or component to the list (see the next topic) CleanSweep displays its safety level 
as blue, indicating that CleanSweep has not given its own safety level to the file

The wizard uses Windows file viewers to let you take a quick peek at a file without having to 
launch the application that created it. After you have verified the file's contents, you can better 
decide whether you wish to move it. This adds another layer of safety to the moving process.

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active. You can 
use the Run button to launch the program.

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active. You can use the Link 
button to display a description of any DLL the file uses, or any programs that depend 
upon that file.

2 Click the View or Run button.

The file appears (or the program launches).

To see a file description without launching the file:

· Select the filename in the list.

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to move, you should clear their check boxes.

To prevent a file from being moved:

· Clear the check box by clicking on it.

To add a file to the list:

1 Click the Add button. 

The Add Component dialog box appears.



2  Type a filename in the file entry area, then click OK.

You may specify a filename, or you may choose to remove sections from the WIN.INI 
file. The WIN.INI file contains sections that are often shared between programs from 
the same vendor, so only select a section if you are absolutely sure it is not used by 
another program.

To print the list:

1 Click the Print List button.

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Selecting a Destination
Before CleanSweep moves anything, it asks where you want to store the program.

To select a destination:

1 Click the Next button.

A dialog box provides a input area for the destination.

You can type a destination name or choose a different destination by clicking on the 
… button and browsing for a destination.    The destination can be a floppy or network 
drive.

2 Click the Next button to store the program in the currently selected destination.



Viewing a Summary
When the move is complete, a dialog box reports the action as completed, and asks if you want 
to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears.The text window contains a detailed description of the 
actions performed, including the following:

· Date and time that the move was performed

· Object that was moved

· Move destination

· Title of the folder, if applicable

· Title of the program 

· The complete pathname for each program in the folder or group 

· Description of the program 

· Number of bytes moved. 

NOTE:    The number of bytes moved might be slightly larger than the approximate estimate 
(listed just before you click the Finish button) due to "slack space."    Each file is stored in clusters 
of a certain size, depending on the hard disk's partition size.    The last cluster of a file takes a full 
cluster, whether it uses the space or not.    For example, if your hard disk partition contained 
4096-byte clusters, moving a 4097-byte file would would be reported as moving 8192 bytes.

To print the report:

· Click the Print button.

The report is printed.

To save the report in a file:

1 Click the Save button.

The Save Summary to File dialog box appears.

2 Type a filename for the report, then click Close.

To close the report:

· Click the Close button.

The report closes.

MORE INFO:  The summary report describes only the activity that has just been performed. For a 
report on all of CleanSweep's activity, take a look at the Master Log report, as described in View 



Master Log.



Moving files

Use the Move option to move files to another folder (directory and/or drive) on your computer. 
The files in the original folder or directory will be deleted.

To move files:

1 Click Move and then click Next.

2 Type the name of the folder, or click on the …button to browse for a destination folder 
or directory. Click Next to accept the folder you have chosen.

3 Click View to see a list of files that are to be moved. Click Finish to move the files.

4 After the files have been moved, you may click on Summary to see a report of the 
action that was just performed, or you may click on OK to return to the Cleanup tab.



Packaging
When you have reviewed the summary information and are satisfied that it is correct, you are 
ready to package.

To package the program:

1 Click the Finish button.

That's all there is to it. CleanSweep creates a compressed file. 

If you want to see more details on what CleanSweep did, you can view a summary, 
as described in the next topic.

2 When you have finished viewing the summary, click the OK button.



Preventing the Install Monitor from loading at startup

Windows automatically loads the Install Monitor when it starts, whether or not you start 
CleanSweep. The monitor must be running to track program installation information.    However, 
you can prevent the Install Monitor from loading when Windows starts.

To prevent the Install Monitor from running when Windows starts:

1 Click the Load Install Monitor at Startup check box to clear it.

2 Click Apply to prevent the Install Monitor from loading at Windows startup without 
exiting the Install Monitor tab.

Or

· Click OK to prevent the Install Monitor from loading at Windows startup and exit the 
Install Monitor tab.



Preventing the Usage Monitor from loading at startup

Windows automatically loads the Usage Monitor when it starts, whether or not you start 
CleanSweep.    The monitor must be running to track and report accurate information on how 
often files are used.    However, you can prevent the Usage Monitor from loading when Windows 
starts.

To prevent the Usage Monitor from running when Windows starts:

1 Click the Load Usage Monitor at Startup check box to clear it.

2 Click Apply to prevent the Usage Monitor from loading at Windows startup without 
exiting the Usage Monitor tab.

Or

· Click OK to prevent the Usage Monitor from loading at Windows startup and exit the 
Usage Monitor tab.



Receiving a reminder to remove old backup files

CleanSweep can remind you when a backup file is older than a specified number of days.    The 
default is 90 days.

To turn the backup reminder option off:

1 Clear the box: Remind me if any backups created while uninstalling are older 
than 90 days.

The checkmark disappears.

2 Click Apply to turn the backup reminder option off without closing the 
Backup/Restore tab

Or

Click OK to turn the backup reminder option off and exit the Backup/Restore tab.

To change the backup reminder time:

1 Type a new number over the old in: Remind me if any backups created while 
uninstalling are older than 90 days.

2 Click Apply to change the backup reminder time without closing the Backup/Restore 
tab

Or

· Click OK to change the backup reminder time and exit the Backup/Restore tab.



Overview
In this topic you will learn:

· How to view and print the Master Log report of all CleanSweep activity.

· How to view and print the Savings report, which details how much disk space 
CleanSweep has saved for you.

The View tab on the main window includes two reports that summarize all CleanSweep activity, 
including how much disk space was saved as a result of using CleanSweep.



File Information

To view the file information report for all files in a particular folder, double-click the folder or click 
the Files button in the View Folder Usage window.    You can also choose Print or Save to print a 
copy of the report or save it to a file.

The File Information report provides the following information for each file:

Relative percent The disk space used by the file as a percentage of the total space used 
by all files in the folder.

Actual size Actual space used by the file.

Allocated size Total space allocated for the file.

Percent wasted The difference between the allocated size and the actual size for the file 
(slack space).



Overview
In this topic you will learn:

· How to restore a previously backed up program and its related components. 

· How to view a summary report of what was restored.

The Restore wizard uses a backup file to restore files to their original state.    You might want to 
restore files if you uninstalled, archived, or backed up files and later decide that you want them 
back.    (CleanSweep creates a backup file during an uninstallation only if you specify that it 
should do so.)    You will also use the Restore wizard as the final step after moving or transporting 
a program. 

The basic steps to restoring a program are:

1. Run the Restore wizard

2. Select the program to restore

3. Specify what to do if older files by the same name exist and whether you want    to have the 
wizard verify each file restoration before it happens.

4. Review which files will be restored.

5. Restore the program.

The next topics describe these steps in detail.



Restoring
When you have reviewed the summary information and are satisfied that it is correct, you are 
ready to restore.

To restore the program:

1 Click the Next button.

That's all there is to it.    The files are restored.    If you want to see more details on 
what CleanSweep did, you can view a summary, as described in the next topic.

2 When you have finished viewing the summary, click the Finish button.



Taking Safety Precautions
The Restore wizard provides two optional safety precautions:    overwrite protection and 
confirmation of each file replacement.

Related topics:

File replacements

For extra safety



Viewing a Summary
When the restoration is complete, a dialog box reports the action as completed, and asks if you 
want to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears.    The text window contains a detailed description of the 
actions performed, including the:

· Date and time that the restoration was performed

· Object that was restored

· Restore location, if any

· Title of the folder, if applicable

· Title of the program

· The complete pathname for each program in the folder or group 

· Description of the program 

· Number of bytes restored.

To print the report:

· Click the Print button.

The report prints.

To save the report in a file:

1 Click the Save button.

The Save Summary to File dialog box appears.

2 Type a filename for the report and then click Close.

To close the report:

· Click the Close button.

The report closes.

MORE INFO:  The summary report describes one activity at a time.    For a report on all 
CleanSweep activity, take a look at the Master Log report, as described in View Master Log.



Running the Archive Wizard
To run the Archive wizard:

· Click the Archive wizard icon in the CleanSweep Program tab.

The Archive wizard lists every Program folder on your hard drive.    In Windows 95, 
these are the folders in the Program section of the Start Menu.

The wizard will guide you through the archiving process.



Running the Backup or Transport Wizard
To run the Backup or Transport wizard:

· Click the appropriate wizard icon in the CleanSweep Program tab.

The wizard lists every Program folder on your hard drive. In Windows 95, these are 
the folders in the Program section of the Start Menu.

The wizard will guide you through the packaging process.



Running the Move Wizard
To run the Move wizard:

· Click the Move wizard icon in the CleanSweep Program tab.

The Move wizard lists every Program folder on your hard drive.    In Windows 95, 
these are the folders in the Program section of the Start Menu.

The wizard will guide you through the moving process.



Running the Restore Wizard
To run the Restore wizard:

· Click the Restore wizard icon in the CleanSweep Restore tab.

The Restore wizard lists every backup file in the default backup folder.    You can 
change to another backup folder, as described in Browsing for a backup. 

The wizard will guide you through the restoring process. 



Running the Uninstall Wizard
To run the Uninstall wizard:

· Click the Uninstall wizard icon in the CleanSweep Program tab.

The Uninstall wizard lists every Program folder on your hard drive.    In Windows 95, 
these are the folders in the Program section of the Start Menu.

The wizard will guide you through the uninstalling process. 



Savings
The Savings report displays the amount of disk space freed by the Uninstall Program Wizard and 
the File Finders, the disk space used by backups, and the net disk space savings.

To view the Savings log report:

· Click the View Savings icon.

The Savings report appears. All totals are in kilobytes (KB).

The first portion of the report shows the disk space freed by the wizards and the finders, and then 
the total disk space freed.

The second portion of the report shows the disk space used by CleanSweep backup and archive 
files, and the total amount of disk space used by these files.

The last section of the report displays your total overall savings.The number is derived from the 
total disk space freed minus the total amount of disk space needed to store archive and backup 
files.

To clear the Savings report:

1 Click the Clear button.

A dialog box asks if you are sure you want to clear theSavings log.

2 Click Yes to clear the log

The program resets the values to zero, and begins a fresh log of disk space savings.



Selecting DLL or VBX Files

The scrollable list shows the name, path, version, date, and time of each redundant DLL or VBX 
file, and the number of times the file has been found. It also lists the number of times the files 
have been accessed since CleanSweep's Usage Monitor has been enabled (the default is 1). 
Files are listed alphabetically. Beside each listed file is a box, color-coded to indicate the safety 
level associated with deleting the file. A red box signifies that the file is in use and cannot be 
deleted. A yellow box appears next to files that have the same name as a file in the \WINDOWS 
or \WINDOWS\SYSTEM directory, but which are not the same version. Such files should be 
deleted with caution. A green box indicates that the file is clearly redundant, and can be removed 
safely. In the Redundant File Finder, such files are preselected for deletion.

To select DLL or VBX files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that the checkmark displays in its check box. While the 
file is highlighted, you may choose to display more information about it (see in the 
next topic).

3 To deselect a single file, click its yellow or green box. To deselect all files, click the 
Deselect All button.

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

IMPORTANT:    Use caution when deleting redundant DLL or VBX files. Some programs may 
require particular versions of the DLL or VBX files to run properly. Always make a backup of the 
files you are deleting.

The following actions are available in the Redundant DLL Finder.

Action What it Does

Clean Begins the backup and deletion process. 
Clean provides several options for 
handling selected files (see Cleaning Up 
Unneeded Files).

Advise Offers a summary describing the 
highlighted file in more detail, and advice 
on what to do with it.the highlighted file.

View Activates a Windows viewer or launches 
an application for the highlighted file.    If 
the file is in a format unknown to 



Windows, but contains mostly text, the 
contents of the file appears. For most 
Windows application and system files, a 
summary of information from the file's 
header appears. The button is only active 
if a file is highlighted in the scrolling 
window.

Links Activates a dialog that lists files that use 
this file, or files that this file uses.This 
button is activated only if a DLL or VBX 
file is selected.

Deselect All Deselects all selected files in the scrolling 
window.



Selecting File Sorting Options

CleanSweep can displays its list of files based on criteria you choose:

To select the file sorting option:

1 Click the Sort Files By drop-down button. 

The file sorting options appear.

Sort Option What it Does

Size Sorts files by size.

Access Sorts files by access count.

Last Access Date Sorts files by the last time they were accessed 
(note that this is not necessarily the last time they 
were changed).

Last Change Date Sorts files by the last time they were changed.

File Name Sorts files alphabetically by filename.

Type Sorts files by type (file extension).

Unsorted Displays the files in unsorted form.

2 Select the desired sort option or choose Unsorted to display the files without sorting 
them.



Selecting File Sorting Order

The default sort order is descending order. You can switch to ascending order if you wish.

To switch to Ascending Order:

· Click the Sort Files In drop-down list, then select Ascending Order.



Selecting File Type

Use the Files of Type option to limit the search for duplicate files in specific categories.

To select the file type:

1 Click the Files of Type drop-down button. 

The list of file type choices appears.

File Type Searches For

All Files Infrequently used files of all types. This is 
the default selection. It finds the most files, 
but takes the longest time.

(Add Custom File 
Type)

Files with a specific file extensions. Type 
the file extension, or a list of extensions, in 
the Add Custom File Type dialog.

Programs BAT, COM, EXE, or PIF (Windows 
Program Information File) files.

Dynamic Link 
Libraries

DLLs and VBXs.

2 Click the desired file type or choose Add Custom File Type to enter a specific file 
extension.



Selecting Files

The lower scrollable list shows the names, size, path, date, and time of the duplicate files 
CleanSweep has found. It also lists the number of times the files have been accessed since 
CleanSweep's Usage Monitor has been enabled (the default number is 1). Beside each listed file 
is a yellow box indicating that duplicate files should be deleted with caution. Below the file list is 
an icon that tells you the kind of file that is currently highlighted. You can select any file from the 
list and mark it for deletion. You can also have CleanSweep give you more information about the 
file so you can decide what to do with it.

To select duplicate files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete. To select a file, 
click anywhere on its line so that the checkmark displays in its check box. While the 
file is highlighted, you may choose to display more information about it (see in the 
next topic).

3 To deselect a single file, click anywhere on its line to remove the checkmark. To 
deselect all files, click the Deselect All button.

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

The following actions are available in the Duplicate File Finder.

Action What it Does

Clean Begins the backup and deletion process. 
Clean provides several options for 
handling selected files (see Cleaning Up 
Unneeded Files).

Advise Offers a summary describing the 
highlighted file in more detail, and advice 
on what to do with it.

View Activates a Windows viewer or launches 
an application for the highlighted file.If the 
file is in a format unknown to Windows, 
but contains mostly text, the contents of 
the file are displayed. For most Windows 
application and system files, a summary of 
information from the file's header is 
displayed. The button is only active if a file 
is highlighted in the scrolling window.



Links Activates a dialog that lists files that use 
this file, or files that this file uses. This 
button is activated only if a DLL or VBX 
file is selected.

Run Executes the highlighted file. This button 
is activated only if the selected file is 
executable (BAT, COM, EXE, or PIF), or is 
associated by Windows with a specific 
application.

Deselect All Deselects all selected files in the scrolling 
window.

IMPORTANT:    It is almost always unwise to remove all copies of a duplicated file. You should 
determine which files are needed and delete only the unneeded files. Always make a backup if 
you are not certain the file may be safely deleted.



Selecting Orphan Files

The lower scrollable list shows the name, size, path, date, and time of each orphan file in the 
category selected above. It also lists the number of times the files have been accessed since 
CleanSweep's Usage Monitor has been enabled (the default number is 1). Beside each listed file 
is a box, color-coded to indicate the safety level associated with deleting the file. A yellow box 
appears next to files that CleanSweep believes may be useful. Such files should be deleted with 
caution. A green box indicates that the file or association is clearly useless, and can be removed 
safely.

To select orphan files:

1 Click the check box beside the pathname for the selected file. 

2 Scroll through the list and select all of the files you want to delete.To select a file, click 
anywhere on its line so that the checkmark displays in its check box. While the file is 
highlighted, you may choose to display more information about it (see the next topic).

3 To deselect a single file, click its yellow or green box. To deselect all files, click the 
Deselect All button.

4 Choose an action for the selected files by selecting the appropriate button (buttons 
are selectable only if a file is highlighted in the window).

Action What it Does

Clean Begins the backup and deletion process. Clean 
provides several options for handling selected files 
(see Cleaning Up Unneeded Files).

Advise Offers a summary describing the highlighted file in 
more detail, and advice on what to do with it.

Attach Activates a dialog for adding the selected 
executable file (EXE only) to    a new folder or 
program group. CleanSweep can add a program 
to an existing group or can create a new program 
group for you.

View Activates a Windows viewer, if one is available, or 
launches an application (such as WordPad or 
NotePad) for the highlighted file. For most 
Windows application and system files, a summary 
of information from the file's header appears. The 
button is only active if a file is highlighted in the 
scrolling window.



Links Activates a dialog that lists files that use this file, 
or files that this file uses. This button is activated 
only if a DLL or VBX file is selected.

Run Executes the highlighted file. This button is 
activated only if the selected file is executable 
(BAT, COM, EXE, or PIF), or if the file is 
associated by Windows with a specific program.

Select All Selects all files in the scrolling window.

Deselect All Deselects all files in the scrolling window.

MORE INFO:    See Cleaning Up Unneeded Files for details on how to use the Clean options.



Selecting Which Files to Restore

CleanSweep determines which files are in the backup file and displays a list.    You can either 
choose to restore all the files or you can remove files from the list to restore a portion of the 
program.

To restore all files:

· Click Next.

To remove a file from the list:

1 To remove a file from the list, clear its checkbox.

2 Click Next.



Selecting a Backup
The methods you can use to find and select a backup are:

· Select the backup from the backup folder list.

· Browse for a folder and then select a backup for it.

Related topic:

Selecting from the default backup folder



Selecting a Finder
To select a Finder:

1 Click the Cleanup Tab.

The Cleanup tab shows the Finders.

2 Click the icon for the desired Finder.

Finder What it Does

Duplicate File Finder Finds duplicate copies of files by 
name and size, or by criteria that you 
specify.

Redundant DLL Finder Finds DLL (Dynamic Linked Library) 
and VBX (Visual Basic eXtension) 
files that exist in more than one 
location.

Unused File Type Finder Finds files in categories that are 
typically unused, for example, screen 
savers, backup files, or fonts.

Low File Usage Finder Finds files based on the number of 
times they have been accessed.

Orphan Finder Finds files related to applications that 
are no longer installed on your 
computer.



Selecting a Restore Location
Before CleanSweep restores anything, it asks if you would like to restore the files to the same 
location they were previously stored.

To restore the files to their original location:

· Click the Next button.

To change the location:

1 Click the No button.

2 Click the Next button.

3 Type the folder or group to which you wish to restore the program.

4 Click the Next button.

CleanSweep displays a summary of what it is about to do.    The summary includes which files will 
be restored and the number of bytes of disk space that will be freed.



Selecting an Archive Folder
Before CleanSweep archives anything, it asks where you want to store the archive.

To select an archive folder:

1 Click the Next button.

A dialog box shows the name of the default archive folder, which by default is

C:\PROGRAM FILES\CLEANSWEEP\BACKUP

You can choose a different archive folder by editing the displayed folder name or by 
clicking the … button and browsing for a different archive folder.

2 Click the Next button to store the archive in the currently selected folder.



Selecting from the default backup folder

The Restore wizard displays all backup files in the default backup folder.

To select a backup from CleanSweep's default backup folder:

1 Click the backup you want to restore. 

2 Click the Next button.

Related topic:

Browsing for a backup



Selecting the Drive to Search

By default, CleanSweep's Finders will restrict their searches to local hard drives. Use the Drives 
to Search option to select a floppy or other removable drive, or network drives.

To select the drive to search:

1 Click the Drives to Search box.

The Select Drive dialog box appears.

2 Click the desired drives to search.

3 Click OK to confirm your drive selection.



Selecting the Orphan Type

The scrollable list at the top of the window gives a list from which you can select various 
categories of orphan files. CleanSweep displays the number of files and the total size of the files 
in each category. CleanSweep also uses color to display the safety level of each type of file.

Orphan Type Definition

Empty Groups Groups within your Windows 
shell which no longer contain 
any icons.

Orphan DLLs DLLs that may have been left 
behind when their associated 
programs were deleted.

Orphan File Associations In WIN.INI, entries that tell 
Windows which program to run 
when a given document file is 
launched, but for which the 
program is missing.

Orphan Icons Icons in your shell which are 
invalid because the programs 
to which they refer have been 
deleted.

Orphan INI Files INI (initialization) files which 
are no longer useful because 
the programs to which they 
refer have been deleted

Orphan OLE Embeddings Entries in the OLE (Object 
Linking and Embedding) 
database which are no longer 
valid because they are 
associated with a    program 
that has been deleted.

Orphan OLE Objects Entries referrring to OLE in the 
Registry that are no loger valid 
because they are associated 
with a program that has been 
deleted.

Orphan Programs Windows programs for which 
no icons exist in your shell.

Zero-Byte Files Files that have a size of 0.

IMPORTANT: Orphan Windows programs may be useful, or may be parts of other programs on 



your system, even though they don't have icons associated with them in your shell. Note also that 
some DOS programs may be displayed as Windows programs here; because such programs are 
stored in the same file format as Windows programs. For these reasons, use care when deleting 
orphan programs, and always make a backup.



Setting Usage Monitor alert options

Use the Alert dialog box to control:

· The number of days a file may remain unused before the Usage Monitor alerts you.

· How often the Usage Monitor checks for unused files.

· What sound the Usage Monitor will use to alert you of unused files.

To define how often you will be alerted:

1 Click the Alert button.

The Alert dialog box appears.

2 Click the box next to Alert if any file is unused for more than 90 days. The default 
is 90 days. 

To change the number of days, type a new number over the old.

3 Click OK.

To define how often the monitor checks for unused files:

1 Click the Alert button.

The Alert dialog box appears.

2 Click Each time usage monitor starts to check for unused files every time the 
usage monitor starts.

Or

Click Every 30 days to check for unused files every 30 days.

To change the number of days, type a new number over the old.

3 Click OK.

To define the alert sound:

1 Click the Alert button.

The Alert dialog box appears.

2 Click If unused files are found, alert with the sound: Type a sound filename, for 
example BELL.WAV, or click the ... button to search for another file.

3 Click OK.



The Cleanup tab

The Cleanup tab contains the Finders that locate specific types of files:    the Duplicate File 
Finder, the Redundant DLL Finder, the Unused File Type Finder, the Low File Usage Finder, and 
the Orphan Finder.    After you locate unneeded files with a Finder, you can delete, archive, back 
them up, move, or transport them.



The Main Window at a Glance
The first window you see when you start CleanSweep is the main window.    You can use this 
window to access any CleanSweep program function. 

The main window contains five tabs:    Program, Cleanup, Restore, View and Options.

Related topics:

The Program tab

The Cleanup tab

The View tab

The Restore tab

The Options tab



The Options tab

The Options tab contains the Configure CleanSweep icon, which customizes CleanSweep to suit 
your personal preferences.



The Program tab

The Program tab contains five wizards--helper programs that guide you step-by-step though a 
particular process.    You can uninstall files, archive files, back up files, move files, or transport 
files to another computer.

The Uninstall wizard deletes programs and all related files in the same folder or program group. 
Uninstall deletes not only the individual components (files) of the program, but also any external 
references to the file, such as program icons or entries in system configuration files (such as the 
Registry or SYS.INI).    The wizard is smart enough to leave program components that are used 
by other programs intact.

The Archive wizard uninstalls programs but saves copies of the program's files in a compressed 
format for future retrieval.    This gives you the best of both worlds, because you can free needed 
space on your hard disk and still retrieve the program whenever you want.    The Archive wizard 
creates a backup of a program file and all related files in the same folder or program group.    The 
original files and configuration information are deleted from your hard drive.    When you need the 
program, click its icon, and CleanSweep restores it.

The Backup wizard creates a single, compressed backup file of a program file and all related files 
in the same folder or program group for use as a reserve in the event that the files need to be 
restored. Backing up leaves all of the original files and configuration information in place.

The Move wizard moves a program file and all related files in the same program group or folder to 
another drive or folder location.

The Transport wizard transports a program file and all related files in the same program group or 
folder to a disk or other storage medium.    Use this wizard to transport data to your laptop, home 
computer, or other computers.

To start any wizard, simply click its icon.    In general, the wizards will guide you through the 
process by asking you a question.    When you have answered the question, click Next.    When 
you are done, click Finish.



The Restore tab

The Restore wizard restores a program to its original state. 



The View tab

The View tab contains three reports that summarize your CleanSweep activities. 

The Master Log keeps track of all of the actions performed, so you can always look up any file or 
activity.    It will also tell you where a backup was stored and how many bytes of disk space were 
freed. 

The Savings report details the amount of space freed, the amount of spaced used by backups 
and the total overall savings. All totals are in kilobytes (KB). 

The Folder Usage report details folder use.



Transporting files

Use the Transport option to copy files to another disk¾typically a floppy disk¾so that you can 
move it easily to another computer (for example, a laptop).

To transport files:

1 Click Transport and then click Next.

2 CleanSweep will display the default transport drive, typically A:. Click on the line 
displaying the default drive if you wish to select a different drive.Click Next to accept 
the currently displayed drive 

3 If you wish, you may click View to see a list of files that are to be transported. Click 
Finish to transport the files to the destination drive.



Turning off Restore Wizard options

The Restore wizard gives you the following options when restoring files that already exist:

· Replace older files only

· Replace all files

· Never replace files, only add files.

Restore also gives you the option of confirming each file before it is replaced.    If you do not want 
to be prompted for these options, you can turn them off.

To turn the restore options off:

1 Click the box In restore wizard, ask what action to take if file already exists.

The checkmark disappears.

2 Click Apply to turn the restore options off without closing the Backup/Restore tab

Or

3 Click OK to turn the restore options off and exit the Backup/Restore tab.



Turning off Uninstall Wizard file confirmation

The Uninstall wizard gives you the option of confirming each file before it is removed.    This is 
usually unnecessary, and is not recommended.

To turn the confirmation option off:

1 Clear the box: In uninstall wizard, ask if confirmation is wanted.

The checkmark disappears.

2 Click Apply to turn the confirmation option off without closing the Backup/Restore tab

Or

· Click OK to turn the confirmation option off and exit the Backup/Restore tab.



Turning the Install Monitor off or on

The Install Monitor must be running to track and report accurate information on programs you 
install. However you can turn it off.

To turn the image monitor off:

1 Click Turn Install Monitor off.

2 Click Apply to turn the Install Monitor off without exiting the Install Monitor tab.

Or

· Click OK to turn the image monitor off and exit the Install Monitor tab.

The Install Monitor shuts down and the taskbar icon disappears.

To turn the install monitor on:

1 Click Turn Install Monitor on.

2 Click Apply to turn the Install Monitor on without exiting the Install Monitor tab.

Or

· Click OK to turn the Install Monitor on and exit the Install Monitor tab.

The Install Monitor runs in the background and the taskbar icon appears.



Turning the Usage Monitor off or on

The Usage Monitor must be running to track and report accurate information on how often files 
are used. However you can turn the Usage Monitor off.

To turn the usage monitor off:

1 Click Turn Usage Monitor off.

2 Click Apply to turn the Usage Monitor off without exiting the Usage Monitor tab.

Or

· Click OK to turn the usage monitor off and exit the Usage Monitor tab.

The Usage Monitor shuts down and the taskbar icon disappears.

To turn the usage monitor on:

1 Click Turn Usage Monitor on.

2 Click Apply to turn the Usage Monitor on without exiting the Usage Monitor tab.

Or

· Click OK to turn the Usage Monitor on and exit the Usage Monitor tab.

The Usage Monitor runs in the background and the taskbar icon appears.



Finding and Selecting a Folder or Program
To find and select a program, you can:

· Select a folder, or open it and select one of the programs inside it.

· Browse or search for a program and then select it.

Related topics:

Selecting a program or a folder

Finding files



Finding files

The methods described in this section locate individual files, rather than entire programs or 
program folders.    These methods can help if you wish to find a program but cannot remember 
where it is stored.    These are also the only way to find orphaned or DOS programs using the 
Uninstall wizard (although you may find such programs easily using options on the Cleanup tab). 

MORE INFO:    You may also use the Cleanup tab to search for specific file types, such as 
duplicate, unused, or orphaned files. 

Related topics:

Browsing for a program

Searching for a program



Selecting a program or a folder

Use this method to select either a program contained within a folder or the folder itself and its 
entire contents.    The Uninstall wizard displays all of your Program folders in alphabetical order.

To select a folder (or a single program inside it):

1 Scroll the list to find the folder.    If you wish to uninstall a single program, find the 
folder that contains the program.

2 To select all of the programs contained in a folder, simply click the folder.    To select a 
single program from within the folder, double-click the folder to display its contents, 
then click the program you want. If you wish to close the folder without selecting a 
program, double-click the folder again.

Note:    If you cannot find a program in a folder, it may be that it is a DOS program or an 
"orphaned program."    DOS programs do not appear in the list but you can use another method to 
find them, as described in the next topic.    An orphaned program is a Windows program for which 
no icon exists in your folders. To select a DOS program or an orphaned program, click Find, and 
then use the Browse button or Search button. Browse lets you locate programs by navigating 
through your folders and making selections with the mouse or by selecting files by name or by 
wildcard.    Search scans your local hard drives for all program files.

More Info:    The Cleanup tab provides the best ways to find specific types of files, for example, 
duplicate or temporary files.    See selecting a finder for more information on finding specific file 
types.

3 Click the Next button or double-click the selected file.

CleanSweep analyzes your hard drive to determine whether the program uses any 
other components.    CleanSweep then asks if you want to back the program up.    
See taking safety precautions.

IMPORTANT:    During its analysis, CleanSweep may determine that you have selected a file or a 
group of files that you should not uninstall. If so, a dialog box will warn you not to uninstall the 
program and will explain the reason why.    You should follow the wizard's recommendations 
unless you are absolutely sure that the file can be safely uninstalled. After the warning, 
CleanSweep continues with the uninstall process.    The files that CleanSweep believes should 
not be uninstalled are color coded in yellow or red.    Later, (in reviewing your selection), 
CleanSweep will give you a chance to remove from the list any files marked in yellow. 
CleanSweep will not remove any files marked in red.



Browsing for a program

Use this method to select any single file from a folder. 

To browse for a program:

1 Click the Browse button.

The Browse for a Program dialog box appears.    The default folder is that of the 
selected program or folder.    If you have not selected a program or folder, the default 
is the folder in which Windows resides. The main window in this dialog box displays a 
scrollable list of files and folders. 

To move up a level in the "folder tree," press the Up One Level button on the toolbar. 
To look in the folder above the current one, or to look on another ddrive, click the list 
box labelled "Look in." To look in a folder within the current folder, double-click the 
folder in the main window below the "Look in" box. 

To see more details about the files and folders in the main window, click the Details 
button on the toolbar.

NOTE:    The dialog box arranges the items alphabetically by name¾folders first, and then the 
files.

2 Select a file or type a filename in the Filename entry field. In Windows 95, a filename 
can be more than eight characters and may contain periods, commas, hyphens, 
exclamation points, and spaces.    If you do not know the entire filename, you can use 
the asterisk (*) or question mark (?) as wildcard characters.    The dialog box displays 
only program files by default.    To display all file types, click the "Files of type" list box, 
and then select All Files (*.*).

3 Click the Open button.

The wizard does a quick analysis of the file, then asks if you want to back it up.    See 
"Taking Safety Precautions."



Searching for a program

Use this method to locate a single file from a list of specific program types, including:    all 
programs, DOS Programs, Windows Programs, or DLLs.

To search for a program:

1 Press the Search button.

The Search for a Program dialog box appears. 

2 The wizard searches all hard drives by default.    To specify other drives to search, 
click the Drives To Search: box, select one or more drives from the dialog box, then 
click OK.

The wizard searches for all types of programs (COM, EXE, BAT, and PIF) by default. 
To narrow the search, click anywhere in the "Files of Type" list box, then choose 
Windows Programs, DOS Programs, or Dynamic Link Libraries.

4 Use the scroll bar to move up and down the file list, and then click the filename to 
select it.

You may only select one program at a time.

NOTE:  Because Windows 95 supports long filenames, some file listings may contain the symbol 
~.    This generally indicates that the long file or folder name is longer than what is displayed in the 
dialog box.

The bottom of the dialog box displays the program's icon, what type of program it is, 
and how many bytes the file occupies. 

5 After you have selected a file, click OK.

The wizard does a quick analysis of the file, then asks if you want to back it up.



Overview
In this topic you will learn:

· How to delete a program and its related components to save space on your computer's hard 
disk, even if the program is used on a network. 

· How to view a summary report of what was uninstalled.

You can reclaim hard disk space easily and safely by uninstalling programs that you no longer 
need.    CleanSweep can remove a single program or all of the programs in a folder.    Program 
files and all of the components associated with them are removed from your computer.    The 
more software you remove, the more disk space you will free and the better your computer will 
perform. 

The basic steps to uninstalling a program are:

1. Run the Uninstall wizard

2. Select the program or folder to uninstall

3. Take optional safety precautions.    You can back up the program and have the wizard verify 
each file deletion before it happens.

4. Review your selection

5. Uninstall the program

The next topics describe these steps in detail.



Reviewing your Selection
Next, the Uninstall wizard displays a summary of what it is about to do.    The summary notes 
which file or files will be uninstalled and the number of bytes of disk space that will be freed.

The View button on this screen lets you see a description and the safety level of each file that 
CleanSweep believes is associated with your choice.    You may be able to view some files to be 
sure you want to uninstall them. You can also change or print the list of displayed files before you 
continue.    You might want to print the list so you can cancel the uninstall and verify each file on 
your own, or, you might keep the printout as a record of what you undeleted or backed up.

If you are sure you want to uninstall all the files listed, continue uninstalling.

Related topic:

Examining the list in more detail



Examining the list in more detail

To examine the list closely:

· Click the View button. 

The Select the Components to Uninstall dialog box displays the title of the folder (if 
any), and the filenames and related components to be uninstalled. The files and 
components are grouped by their "parent" program. By default, CleanSweep will 
preselect for deletion all files with a green safety level¾all files that CleanSweep is 
sure can be uninstalled safely. Files with a yellow safety level are also candidates for 
uninstalling, but CleanSweep will not uninstall them unless you specifically select 
them.    When you add a file or component to the list, CleanSweep displays its safety 
level as blue, indicating that CleanSweep has not given its own safety level to the file.

The wizard can launch Windows file viewers to let you take a quick peek at a file without having 
to launch the application that created it.    After you have verified the file's contents, you can better 
decide whether you want to uninstall it.    This adds another layer of safety to the uninstalling 
process. 

To view the file: 

1 Select the file you want to view. 

If the selected file is an executable program, the Run button becomes active.    You 
can use the Run button to launch the program. 

If the selected file is an executable program, Dynamic Link Library (DLL) file, or a 
Visual Basic extension (VBX) file, the Link button is active.    You can use the Link 
button if you want to display a description of any DLL the file uses, or any programs 
that depend upon that file. 

2 Click the View or Run button.

The file appears (or the program launches). 

To see a file description without launching the file:

· Select the filename in the list. 

The bottom of the dialog box describes what type of file it is and recommends the 
best way to handle it. 

If there are any files you do not want to uninstall, you should clear their check boxes.

To prevent a file from being deleted:

· Clear the check box by clicking on it.

To add a file to the list:

1 Click the Add button. 

The Add Component dialog box appears.



2  Type a filename in the file entry area, then click OK.

You may specify a filename, or you may choose to remove sections from the WIN.INI 
file.    The WIN.INI contains sections that are often shared between programs from 
the same vendor, so only select a section if you are absolutely sure it is not used by 
another program.

To print the list:

1 Click the Print List button. 

The Print List dialog box gives you the choice of sending the list to the printer or 
saving it to a file.

2 Choose a destination for the list and then click OK. 



Taking Safety Precautions
CleanSweep provides two optional safety precautions:    backup and confirmation of each file 
deletion.

Related topics:

Backing up the files

Confirming file deletion



Uninstalling
When you have reviewed the summary information and are satisfied that it is correct, you are 
ready to uninstall.

To uninstall the program:

1 Click the Finish button.

That's all there is to it.    CleanSweep uninstalls the program.    If you want to see 
more details on what CleanSweep did, you can view a summary, as described in the 
next topic.

2 When you have finished viewing the summary, click the OK button.



Viewing a Summary
When the uninstallation is complete, a dialog box reports the action as completed, and asks if you 
want to see a summary.

To see a summary:

· Click the Summary button. 

An in-depth report appears.    The text window contains a detailed description of the 
actions performed, including the following:

· Date and time that the uninstall was performed

· Object that was uninstalled

· Backup destination

· Title of the folder, if applicable

· Title of the program 

· The complete pathname for each program in the folder or group 

· Description of the program 

· Number of bytes deleted.

To print the report:

· Click the Print button.

The report is printed.

To save the report in a file:

1 Click the Save button.

The Save Summary to File dialog box appears.

2 Type a filename for the report, then click Close.

To close the report:

· Click the Close button.

The report closes.

MORE INFO:  The summary report describes one activity at a time.    For a report on all 
CleanSweep activity, take a look at the Master Log report, as described in view master log.



Uninstalling Instructions
This topic explains how to uninstall a complete program from your hard drive.    New users should 
read    Running the Uninstall Wizard before using this quick start. 

To uninstall a program:

1 Start CleanSweep

Click the Start button, point to Programs, and then click the Quarterdeck 
CleanSweep 95 icon.    CleanSweep appears.

TIP:    You can drag and drop a program onto a CleanSweep shortcut icon to start 
CleanSweep, then skip ahead to step 4. 

2 Start the Uninstall Wizard

Click the Uninstall Wizard icon in the Program tab.    The Uninstall Wizard dialog box 
appears.    The wizard will guide you through the uninstall process.

3 Select the Program to Uninstall 

Double-click a folder to open it.    Click the program you want to uninstall.    If you 
cannot find the program in a folder, click the Find button.    Click Next. 

4 Select Safety Precautions 

Click Next to create a backup.    Click Next again if the folder shown is where you 
want your backup copy of the program to go.    To select another folder, click in the 
text box and type another path, or click the ... button and select a folder.    Click Next 
to bypass the confirmation of each item uninstalled. 

5 Start Uninstalling 

Click Next.    The wizard uninstalls the program and asks if you would like to view a 
summary.    Click Summary. 

6 Uninstall Complete!

Click Finish.



Uninstalling on a Network
Suppose you are a network administrator and you want to uninstall a program on a network drive 
because the program is no longer used at your company. CleanSweep can uninstall a program 
from the network drive and remove the program's files and components from all workstations on 
the network.

To remove a program's components from workstations, you tell CleanSweep to create a Network 
Decoy. The Network Decoy is a copy of CleanSweep that acts as a substitute for a network 
program that has been uninstalled. When a user tries to run the program from a workstation on 
the network, they will instead run the Network Decoy, which uninstalls all components of the 
program from their workstation's hard disk. 

IMPORTANT:  Do not delete a program from a network drive unless you are authorized to do so.

When you create a network decoy, you can enter a custom message that the user will see when 
he or she tries to run the program.    For example, you could enter a message like this:

This program is no longer used at this site.    It has been removed from the network drive, 
and its related files will now be removed from your computer to free more disk space.    
Please continue with the uninstall process.

By displaying a message, you let users know what is happening and make them feel more 
comfortable with the uninstall process.

To uninstall a program from a network drive:

1 Click the Uninstall icon on the Program tab.

2 Use the Browse or Search method to select the program you want to uninstall from 
the network drive. 

The Select the Components to Uninstall dialog box appears.

3 Make sure that each component you want to uninstall is marked with a check. To 
select a component, select its check box.    To deselect a component, clear the check 
box.

4 Click the Select this line to create a Network Decoy check box.

5 Click OK.

A dialog box asks you to enter a custom message.

6 Type message to the network users, informing them that the program has been 
deleted. It is a good idea to enter a message that will make it clear that the program 
has been deleted from the network drive and will be deleted from their hard drive to 
free valuable hard drive space.

7 When you are done typing the message, click OK.

A dialog box asks you to specify a Network Decoy type.    The type you select 
depends on whether CleanSweep is installed on the network drive in a location 



accessible by users over the network.

If CleanSweep is accessible by all the users who run the program you are 
uninstalling, select Single Copy.    When the user attempts to access the program, a 
Network Decoy file will be installed on their computer.    This file, along with the 
network copy of CleanSweep, will be sufficient to uninstall the program's files on the 
workstations.

If CleanSweep is not accessible to all the users who run the program, select Multiple 
Copy.    When the user attempts to access the program, those CleanSweep files 
which are necessary to uninstall the program will be installed on their computer. 

8 Select Single Copy or Multiple Copy, whichever is appropriate, then select OK and 
continue uninstalling.

Once the program has been deleted from the network drive, a copy of CleanSweep will be 
installed in its place on the network drive.    Any user who attempts to run the program will instead 
run a copy of CleanSweep that will uninstall all traces of the original program from his or her hard 
drive.



View Folder Usage
The View Folder Usage report shows how much disk space each folder or file uses on your hard 
drive.    Use View Folder Usage to analyze the total space used, free space remaining, and the 
difference between space allocated and actual space used (slack space) for each folder or file. 

Files allocated under DOS may contain excessive slack space.    DOS allocates a minimum 
amount of disk space for a file regardless of its actual size.    This minimum unit of space on the 
disk is known as a cluster, and if a file grows in size the additional space is allocated in units of at 
least one cluster.

For example, if you write a 2K file to a disk with a 4K cluster size, 2K of space (half the alloted 
space) will be wasted, or slack space.    The View Folder Usage report helps you identify files that 
can be deleted or reallocated to make use of this wasted space.

To see the View Folder Usage reports, click the View Folder Usage Icon on the View tab.    The 
View Folder Usage report appears.    To print a copy of the report or save it to a file, click the Print 
or Save button.

The View Folder Usage report provides the following information for each hard drive:

Total size The total space on the drive.

Used space The space currently used.

Free space The difference between the total space and the space currently used.

Percent used The space used as a percentage of the total space on the drive.

Related topics:

Folder Information

File Information



View Master Log
The Master Log report displays all CleanSweep activity in chronological order.

To view the Master log report:

· Click the View Master Log icon.

The Master Log report is a file composed of all of your previous summary reports. For 
more information on what the summary reports contain, see "Viewing a Summary" in 
the appropriate topic.

After you view the master log, you might want to save it to another file, and then clear it, so the 
next time you look at it you will see all new activity.

To save and clear the master log:

1 Click the Save button.

A dialog displays the CleanSweep folder, with the name SAVEREP.TXT in the File 
name text box. You may choose to save the Master Log to a different file name or 
folder. When you are finished, click the Save button and then click OK.

2 Click the Clear button.

A dialog box asks if you are sure you want to clear the Master Log.

3 Click Yes to clear the log.

CleanSweep clears the Master Log and will begin a new version of it.



Viewing or deleting Install Monitor logs

Use the Install Monitor Logs dialog box to view a summary of install monitor activity or delete 
Install Monitor logs. You view or delete a log.

To view install monitor logs:

1 Click the Logs button.

The Install Monitor Logs dialog box appears.

2 Select an existing log to view. 

3 Click Summary.

The Summary of Install Monitor Log dialog box appears.

4 Click Print to print the log, Save to specify a file for saving a copy of the log, or Close 
to finish viewing the log summary.



Welcome to CleanSweep
Welcome to CleanSweep 95, the premier Windows 95 cleanup program!

Windows 95 has already made your computer easier to use.    But to get the most out of Windows 
95, you need to manage your hard disk space.    Today's programs are larger than ever and it is 
likely that at some point you will run out of disk space and find it necessary to delete unnecessary 
or infrequently used programs and files.

Windows programs have long had a tendency to scatter their contents across multiple directories, 
making it difficult to purge your computer of all the program's components.    Windows 95 itself 
takes up even more space.    Your PC probably contains many redundant, obsolete, and unused 
files and programs you no longer use.    Now is the time to clean up your hard disk. 

CleanSweep is the essential uninstaller program for Windows 95, because there is simply no 
other way to clean up the remnants of your old Windows desktop and manage your new 32-bit 
environment properly.    CleanSweep is more than just an uninstall program.    It is a multipurpose 
utility for minimizing hard disk clutter and reclaiming disk space. 

CleanSweep can remove unneeded DOS programs and Windows 16- and 32-bit programs and 
system components.    You can also use it to delete unneeded duplicate files.    The resulting 
increase in available disk space will greatly improve your computer's performance and allow you 
to install new programs.



Where To Go Next
Now that you are familiar with CleanSweep's main window, what you read next depends on what 
you want to do.

To Learn More About See the Topic

Uninstalling a program Running the Uninstall Wizard

Archiving a program Running the Archive Wizard

Backing Up or Transporting a 
program to another computer

Running the Backup or 
Transport Wizard

Moving a program to another 
drive or directory

Running the Move Wizard

Restoring a program to its 
original state

Running the Restore Wizard

Finding specific type of files Selecting a Finder

Activity & Savings Reports View Master Log and 
Savings

Customizing CleanSweep Configuring the Usage 
Monitor    Configuring the 
Install Monitor    and 
Changing Backup and 
Restore Options.



Which wizard should I use?

  

If you want to Use

Make a backup copy of a 
program for insurance against 
loss of data.

The Backup wizard

Save a copy of an older 
program version.

The Backup wizard

            Transport a program from 
your desktop computer to 
another computer, such as your 
laptop.

The Transport wizard

The basic steps to packaging a program are:

1. Run the Backup or Transport wizard

2. Select the program or folder to package

3. Select a destination

4. Review your selection

5. Package the program or folder

The rest of this topic describes these steps in detail.






